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KẾ HOẠCH GIẢNG DẠY

STT Nội dung
Tổng số 

tiết tín chỉ

Trong đó

Lý thuyết
Bài tập, thảo 

luận, kiểm tra
1
2
3
4
5
6
7
8
9

Chương 1
Chương 2
Chương 3
Chương 4
Chương 5
Chương 6
Chương 7
Chương 8
Kiểm tra HP

3
3
5
7
6
7
7
6
1

2
2
3
5
4
5
5
4

1
1
2
2
2
2
2
2
1

Cộng 45 30 15

Phương pháp đánh giá học phần

• Theo quy định hiện hành của Trường Đại học 
Kinh tế quốc dân, cụ thể:

Điểm đánh giá của giảng viên: 10%
Một bài kiểm tra: 30%
Bài thi hết môn: 60% 

• (Điều kiện dự thi: điểm đánh giá của giảng viên 
tối thiểu là 5, điểm kiểm tra tối thiểu là 3)  
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I

ĐỐI TƯỢNG 
NGHIÊN CỨU CỦA 

THỐNG KÊ HỌC

II

MỘT SỐ KHÁI 
NIỆM THƯỜNG 
DÙNG TRONG 

THỐNG KÊ

III

THANG ĐO 
TRONG 

THỐNG KÊ

CHƯƠNG I: GIỚI THIỆU CHUNG 
VỀ THỐNG KÊ HỌC 

Thống kê học là gì?

Sơ lược lịch sử phát triển thống kê học

Đối tượng nghiên cứu của thống kê học và
các phương pháp trong thống kê

I. Đối tượng nghiên cứu của thống kê học
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1. Thống kê học

Thống kê học là khoa học nghiên cứu hệ thống
phương pháp (thu thập, xử lý, phân tích) con số (mặt
lượng) của các hiện tượng số lớn tìm bản chất và tính
quy luật (mặt chất) trong những điều kiện nhất định.

Là một trong những công
cụ quản lý vĩ mô quan
trọng, có vai trò cung cấp
các thông tin phục vụ
quản lý

Thời kỳ
chiếm hữu

nô lệ

Thời kỳ
Phong kiến

Thời kỳ
sản xuất
hàng hóa

Giai đoạn
hiện nay

Phân tích, đánh giá theo
thời gian và không gian

Thể hiện mối quan hệ
lượng chất

Ghi chép các con số

2. Sơ lược về sự ra đời và phát triển của
thống kê học
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3. Đối tượng nghiên cứu của thống kê học

Mặt lượng trong quan hệ mật thiết với mặt chất của
các hiện tượng và quá trình kinh tế - xã hội số lớn
trong điều kiện thời gian và địa điểm cụ thể

Tổng thể thống kê

Tiêu thức thống kê

Chỉ tiêu thống kê

II. Một số khái niệm thường dùng 
trong thống kê
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1. Tổng thể thống kê và đơn vị tổng 
thể

Tổng thể thống kê là hiện tượng số lớn gồm các đơn

vị (phần tử) cần quan sát và phân tích mặt lượng.

Các đơn vị (phần tử) - đơn vị tổng thể.

Các loại tổng thể thống kê

Tổng thể 
tiềm ẩn 

Tổng thể 
bộc lộ 

Theo sự nhận
biết các đơn vị
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Các loại tổng thể thống kê

Tổng thể 
không đồng 
chất 

Tổng thể 
đồng chất 

Theo mục đích
nghiên cứu

Các loại tổng thể thống kê

Tổng thể bộ 
phận 

Tổng thể 
chung 

Theo phạm vi 
nghiên cứu  
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2. Tiêu thức thống kê

Tiêu thức thống kê - đặc điểm của đơn vị tổng thể

được chọn để nghiên cứu

Tiêu thức thực thể

Tiêu thức thời gian

Tiêu thức không gian

Các loại tiêu thức thống kê
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Tiêu thức thực thể

Tiêu thức nêu lên bản chất của đơn vị tổng thể:

- Tiêu thức thuộc tính

- Tiêu thức số lượng

Tiêu thức thuộc tính

- Biểu hiện không trực tiếp qua con số

- Biểu hiện qua đặc điểm, tính chất



18/01/2018

10

Tiêu thức số lượng

- Biểu hiện trực tiếp qua con số

- Con số - lượng biến

Tiêu thức thay phiên

Là tiêu thức chỉ có 2 biểu hiện không trùng

nhau trên một đơn vị tổng thể
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Tiêu thức thời gian

Phản ánh thời gian của hiện tượng nghiên cứu

Tiêu thức không gian

Phản ánh phạm vi (lãnh thổ) của hiện tượng
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3. Chỉ tiêu thống kê

Chỉ tiêu thống kê phản ánh mặt lượng gắn với chất
của các hiện tượng và quá trình KTXH số lớn trong
điều kiện thời gian và địa điểm cụ thể. 

Các loại chỉ tiêu thống kê

Chỉ tiêu giá 
trị 

Chỉ tiêu 
hiện vật

Theo hình thức
biểu hiện
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Các loại chỉ tiêu thống kê

Chỉ tiêu 
tương đối 

Chỉ tiêu 
tuyệt đối

Theo tính chất biểu
hiện

Các loại chỉ tiêu thống kê

Chỉ tiêu 
thời kỳ 

Chỉ tiêu thời 
điểm

Theo đặc điểm về
thời gian
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Các loại chỉ tiêu thống kê

Chỉ tiêu 
Số lượng
(khối lượng)

Chỉ tiêu 
chất lượng

Theo nội dung 
phản ánh

Thang đo định danh

Thang đo thứ bậc

Thang đo khoảng

Thang đo tỷ lệ

III. THANG ĐO TRONG THỐNG KÊ
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THANG ĐO TỶ LỆ
(Ratio Scale)

THANG ĐO KHOẢNG
(Interval Scale)

THANG ĐO THỨ BẬC
(Ordinal Scale)

THANG ĐO ĐỊNH DANH
(Nominal Scale)

Có gốc 0

Có khoảng cách
bằng nhau

Biểu hiệu có 
thứ tự hơn kém

MÔ HÌNH MÔ TẢ CÁC THANG ĐO

Đánh số các biểu hiện 
cùng loại của tiêu thức

Tiêu thức
thuộc tính

Tiêu thức
Số lượng

Ứng dụng SPSS trong quản lý dữ liệu

SPSS (Statistical Package for Social Sciences)
Là phần mềm chuyên dụng xử lý thông tin sơ
cấp. (thông tin được thu thập trực tiếp từ đối
tượng nghiên cứu thông qua bảng hỏi được
thiết kế sẵn)

30
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Các màn hình SPSS

- Màn hình quản lý dữ liệu

- Màn hình quản lý biến

- Màn hình hiển thị kết quả

- Màn hình cú pháp

31

File: tạo file mới, mở file sẵn có, ghi file, in, thoát,…

Edit: undo, cắt, dán, tìm kiếm thay thế, xác lập các mặc định,…

View: hiện dòng trạng thái, thanh công cụ, chọn font chữ,…

Data: các vấn đề liên quan đến dữ liệu,… 

Transform: chuyển đổi dữ liệu, tính toán, mã hóa lại các biến,…

Analyze: các phân tích thống kê,…

Graphs: biểu đồ và đồ thị,…

Utilities: thông tin về các biến và file,…

Window: sắp xếp và di chuyển các cửa sổ làm việc

Help: trợ giúp

Các menu chính

32
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TẠO DỮ LIỆU SPSS TỪ PHẦN MỀM 
KHÁC

• File > Open > Data…

• Trong mục File of type chọn định dạng file phù hợp hoặc
chọn All Files (*.*)

33

Để mở một tệp tin {file} Excel

34

-Tại cửa sổ Data View, từ thanh menu chọn: File / Open / Data... - Trong hộp thoại
Open File, chọn file mà bạn muốn mở
- Trong hộp thoại Open File, chọn nơi lưu giữ file (Look in); chọn loại file (Files of type)
và sau đó chọn tên file (File name)
- Nhắp Open
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* Tạo biến trong cơ sở dữ liệu

Transform >  Compute Variable…

35

Tạo ra một biến mới theo biểu
thức mô tả (Numeric expression)
Biểu thức có thể là một phép tính, 
một hàm,…

Nếu tính theo một điều kiện nào 
đó thì nhấn vào if (đặt điều kiện 
vào tính toán cho biểu thức)

* Tạo biến trong cơ sở dữ liệu

36

Phép toán
+ Cộng
- Trừ
* Nhân
/ Chia
** Luỹ thừa

Toán tử
> Lớn hơn
< Nhỏ hơn
>= Lớn hơn hoặc bằng
<= Nhỏ hơn hoặc bằng
= Bằng
~= Không bằng
& Và
| Hoặc
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* Mã hoá lại dữ liệu

37

- Mã hoá lại dữ liệu thành một biến khác

• Chọn các biến muốn mã hoá, 
Nếu chọn nhiều biến, chúng
phải có cùng dạng (chuỗi hoặc
số)
• Nhắp vào Old and New Values 
và định rõ cách mã hoá lại trị
số.
• Sau đó nhấn Change

Transform > Recode into Different Variables…

Nhấn If để xác định một nhóm các đối
tượng cũng giống như đã được mô tả
trong mục tính toán biến {Compute 
Variable}

II

ĐIỀU TRA 
THỐNG KÊ

III

TỔNG HỢP THỐNG 
KÊ

IV

PHÂN TÍCH VÀ DỰ 
ĐOÁN THỐNG KÊ

CHƯƠNG II: QUÁ TRÌNH NGHIÊN CỨU 
THỐNG KÊ
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I. ĐIỀU TRA THỐNG KÊ

Khái niệm chung về điều tra thống kê1

Phân loại2

Phương án điều tra thống kê4

Sai số trong điều tra thống kê 5

Các hình thức thu thập thông tin3

1. Khái niệm điều tra thống kê

Khái niệm:

Điều tra thống kê là tổ chức một cách khoa học và
theo một kế hoạch thống nhất việc thu thập tài liệu về
các hiện tượng nghiên cứu.

Yêu cầu:
- Chính xác
- Kịp thời.
- Đầy đủ
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2. Các loại điều tra thống kê

Điều tra không
thường xuyên

Điều tra thường
xuyên

Theo tính chất liên tục 
của việc ghi chép

Điều tra
không toàn bộ

Điều tra toàn bộ

Theo phạm vi đối 
tượng được điều tra  

2. Các loại điều tra thống kê
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Điều tra không toàn bộ

Điều tra 
trọng điểm

Điều tra chuyên
đề

Điều tra 
chọn mẫu

3. Các hình thức thu thập thông tin

 Báo cáo thống kê định kỳ

 Điều tra chuyên môn
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4. PHƯƠNG ÁN ĐIỀU TRA THỐNG KÊ

Nội dung 4

Nội dung 3

Nội dung 2

Nội dung 1

Chọn phương pháp thu thập thông tin 

Xác định nội dung điều tra 

Xác định phạm vi, 
đối tượng và đơn vị điều tra 

Xác định mục 
đích nghiên cứu 

Nội dung 7

Nội dung 6

Nội dung 5

Lập kế hoạch tổ chức và tiến hành điều tra 

Chọn mẫu điều tra 

Soạn thảo bảng hỏi 

5. Sai số trong điều tra thống kê

 Là chênh lệch giữa trị số thu được qua điều tra so với trị

số thực tế của hiện tượng

 Phân loại:

- Sai số do đăng ký ghi chép:

- Sai số do tính chất đại biểu (ĐTCM)
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II. Tổng hợp thống kê

Khái niệm tổng hợp thống kê1

Phương pháp tổng hợp thống kê2

1. Khái niệm

Tổng hợp thống kê là tiến hành tập trung chỉnh lý và
hệ thống hoá một cách khoa học các tài liệu thu thập
được trong điều tra thống kê.
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2. Phương pháp tổng hợp

- Phân tổ thống kê

- Bảng thống kê

- Đồ thị thống kê

III. Phân tích và dự đoán thống kê

Khái niệm:

Phân tích và dự đoán thống kê là nêu lên một cách
tổng hợp bản chất cụ thể và tính quy luật của các
hiện tượng số lớn trong điều kiện nhất định qua biểu
hiện bằng số lượng và tính toán các mức độ của hiện
tượng trong tương lai nhằm đưa ra các căn cứ cho
quyết định quản lý.
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I

PHÂN TỔ 
THỐNG KÊ 

II

BẢNG THỐNG KÊ 
VÀ ĐỒ THỊ THỐNG 

KÊ 

CHƯƠNG III: TRÌNH BÀY DỮ LIỆU THỐNG 
KÊ

2.1. Phân tổ thống kê

Khái niệm, ý nghĩa và nhiệm vụ của phân tổ thống kê 

Các loại phân tổ thống kê

Các bước tiến hành phân tổ thống kê
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Khái niệm phân tổ thống kê

Phân tổ thống kê là căn cứ vào một (hay một số) 
tiêu thức nào đó để tiến hành phân chia các đơn
vị của hiện tượng nghiên cứu thành các tổ (và
các tiểu tổ) có tính chất khác nhau

Ý nghĩa phân tổ thống kê

Có ý nghĩa trong cả quá trình nghiên cứu thống kê

• Giai đoạn điều tra thống kê: nhằm phân tổ đối tượng điều tra
thành những bộ phận có đặc điểm tính chất khác nhau là cơ
sở cho việc lựa chọn các đơn vị điều tra thực tế

• Giai đoạn tổng hợp thống kê: là phương pháp cơ bản để tiến
hành tổng hợp thống kê

• Giai đoạn phân tích thống kê: là cơ sở để vận dụng các
phương pháp phân tích thống kê khác
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Nhiệm vụ phân tổ thống kê

• Phân chia các loại hình KTXH.

• Biểu hiện kết cấu của hiện tượng nghiên cứu.

• Nghiên cứu mối liên hệ giữa các tiêu thức.

Các loại phân tổ thống kê

Phân tổ thống kê

Nhiệm vụ phân tổ 
thống kê 

Số lượng tiêu thức 
phân tổ

Phân tổ 
phân loại

Phân tổ 
kết cấu

Phân tổ 
liên hệ

Phân tổ theo 
một tiêu thức

Phân tổ theo 
nhiều tiêu thức

Phân tổ 
kết hợp

Phân tổ nhiều 
chiều
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Các bước phân tổ thống kê

Phân phối các đơn vị vào từng tổ

Xác định số tổ và khoảng cách tổ

Lựa chọn tiêu thức phân tổ

Xác định mục đích phân tổ

Bước 4

Bước 3

Bước 2

Bước 1

2. Bảng thống kê

Bảng thống kê là một hình thức trình bày các tài liệu thống

kê một cách có hệ thống, hợp lý và rõ ràng, nhằm nêu lên các

đặc trưng về mặt lượng của hiện tượng nghiên cứu
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Tác dụng của bảng thống kê

- Dễ dàng, đối chiếu, so sánh số liệu, có sức thuyết phục

- Giảm thiểu số liệu các giá trị của dữ liệu trong văn bản

- Thu hút sự chú ý của độc giả

Cấu trúc bảng thống kê

TIÊU ĐỀ BẢNG

Tiêu đề
dòng

Tiêu đề cột

Dữ liệu

Ghi chú (nếu có)
Nguồn thông tin:
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Các loại bảng thống kê

Bảng giản đơn: là loại bảng thống kê, trong đó hiện

tượng chỉ phân tổ theo một tiêu thức nào đó

Bảng kết hợp: là loại bảng thống kê trong đó đối tượng 

nghiên cứu được phân chia theo từ hai tiêu thức trở lên

Nguyên tắc khi trình bày bảng thống kê

- Quy mô bảng vừa phải

- Đơn vị tính – nếu tất cả có cùng đơn vị tính thì ghi góc

phải phía trên bảng

- Các cột nên cách nhau đều, độ rộng vừa với nội dung

- Các chỉ tiêu được sắp xếp theo thứ tự hợp lý

- Không được để trống ô nào trong bảng, nếu không có

dữ liệu thì ghi bằng các ký hiệu
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Nguyên tắc ghi ký hiệu

- Nếu hiện tượng không có số liệu, ghi ( - )

- Nếu số liệu còn thiếu, có thể bổ sung ( … )

- Nếu hiện tượng không liên quan ( x )

3. Đồ thị thống kê

Là các hình vẽ hoặc đường nét hình học dùng để

miêu tả có tính chất quy ước các tài liệu thống kê
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Tác dụng của đồ thị

- Hình tượng hoá các số liệu nhằm so sánh, nghiên cứu

kết cấu, xu hướng, mối liên hệ,….

- Giúp đơn giản hoá các mối quan hệ phức tạp

- Có được những phác thảo cơ bản về hiện tượng

- Người đọc ghi nhận thông tin một cách nhanh chóng

- Sinh động, có sức hấp dẫn

Các loại đồ thị

- Đồ thị phát triển

- Đồ thị kết cấu

- Đồ thị so sánh

- Đồ thị liên hệ

- Đồ thị “tháp dân số”
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Các thành phần của đồ thị thống kê

Các thành phần của dữ liệu dùng để trình bày dữ liệu: 

các thanh, đường thẳng, các khu vực hoặc các điểm.

Các thành phần hỗ trợ trong việc tìm hiểu dữ liệu: tiêu 

đề, ghi chú, nhãn dữ liệu, các đường lưới, chú thích và 

nguồn dữ liệu.

Các thành phần dùng để trang trí không liên quan đến 

dữ liệu.

Nguyên tắc trình bày đồ thị

- Quy mô của đồ thị hợp lý (chiều dài, chiều cao).

- Lựa trọn dạng đồ thị phù hợp

- Khoảng cách giữa các cột hợp lý

- Thang đo, tỷ lệ xích phù hợp (tỷ lệ 1: 1,33 hoặc 1:1,5)

- Không nên có quá nhiều hiện tượng trong một đồ thị
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Nguyên tắc trình bày đồ thị

- Quy mô của đồ thị hợp lý (chiều dài, chiều cao).

- Lựa trọn dạng đồ thị phù hợp

- Khoảng cách giữa các cột hợp lý

- Thang đo, tỷ lệ xích phù hợp (tỷ lệ 1: 1,33 hoặc 1:1,5)

- Không nên có quá nhiều hiện tượng trong một đồ thị

Ứng dụng SPSS trong lập bảng thống kê

Analyze > Tables > Custom Tables...

Đưa các biến chủ đề vào

Rows hoặc Columns

Chọn các thống kê theo Cột

(Columns) hoặc dòng

(Rows), Ẩn nhãn (tên) các

thống kê (Hide), 
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Chọn N Summary Statistic…

Chọn các thống kê cần hiện thị chuyển sang mục Display

Đặt lại nhãn (Label) thay đổi định dạng (Format, Decimal)

Nhấn Apply to Selection

Chọn Catagories and Total…

Sắp xếp các biểu hiện chọn Sort categories by (value, count,….) và theo thứ tự tang

(Ascending) hoặc giảm (Descending)

Nhấn Apply

Không muốn hiện thị biểu hiện nào đó ->

chuyển biểu hiện đó sang Exclude

Chọn Total và đặt lại nhãn (Label) nếu

muốn hiện thị dòng tổng số

Hiện thị giá trị khuyết thiếu tích vào

Missing Value

Hiện thị biểu hiện không có quan sát tích

Empty categories

Dòng tổng số để trên (Above) dưới (Below)
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Đặt tiêu đề bảng,… (Titles)

Ghi tên bảng vào ô Titles:

Điền ghi chú, nguồn thông tin,… ở dưới bảng vào ô: Caption

Điền tiêu đề (giữa cột và dòng) vào ô Corner

Ứng dụng SPSS trong vẽ đồ thị thống kê

Simple đồ thị thanh cho 1 biến

Clustered đồ thị thanh kết hợp 2 biến (theo nhóm với

nhiều cột cạnh nhau)

Stacked Đồ thị thanh kết hợp 2 biến (biến được biệu

hiện trên 1 cột)

Summaries for groups cases Mỗi thanh của đồ thị thể

hiện số lượng các quan sát có cùng 1 giá trị của biến

Summaries for separate variables Mỗi thanh của đồ

thị thể hiện giá trị thống kê của biến

Value of individual cases Mỗi thanh của đồ thị thể hiện

giá trị 1 quan sát của biến

Đồ thị thanh (Bar) Graphs > Lagacy > Dialogs > Bar...
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Đồ thị thống kê

Bars Represent tham số thống kê thể hiện trên đồ

thị

Category Axis Trục hoành

Define Clusters by biến phân loại

Có thể vẽ theo dòng hay cột (theo biến phân loại

thứ 2)  đưa biến vào Panel by Rows (Columns)

Đồ thị thanh (Bar) Graphs > Lagacy > Dialogs > Bar...

I

SỐ TUYỆT ĐỐI VÀ 
SỐ TƯƠNG ĐỐI 

TRONG 
THỐNG KÊ

II

CÁC MỨC ĐỘ 
TRUNG TÂM

III

CÁC THAM SỐ ĐO 
ĐỘ 

BIẾN THIÊN 
(PHÂN TÁN)

CHƯƠNG III: CÁC THAM SỐ CỦA PHÂN 
PHỐI THỐNG KÊ
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I. Số tuyệt đối và số tương đối trong
thống kê

Số tuyệt đối trong thống kê1

Số tương đối trong thống kê2

Điều kiện vận dụng số tuyệt đối và số tương đối trong thống kê3

1. Số tuyệt đối trong thống kê

Khái niệm

Đơn vị tính

Các loại
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Khái niệm số tuyệt đối

Số tuyệt đối trong thống kê biểu hiện quy mô, số 
lượng của hiện tượng nghiên cứu tại thời gian, địa 
điểm.

Đơn vị tính số tuyệt đối

- Đơn vị hiện vật: cái, con, quả, chiếc, m, kg, giờ, ngày…

- Đơn vị giá trị: VND, USD,…

- Đơn vị kép: tấn-km, kwh,..
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Thời điểm: quy 
mô khối lượng 

tại một thời 
điểm nhất định

Thời kỳ: quy 
mô khối lượng 

trong một 
khoảng thời 

gian

Số tuyệt đối

Các loại số tuyệt đối

2. Số tương đối trong thống kê

Khái niệm

Đơn vị tính

Các loại
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Khái niệm số tương đối

Số tương đối trong thống kê biểu hiện quan hệ so 

sánh giữa hai mức độ nào đó của hiện tượng. 

Đơn vị tính

 Lần, phần trăm (%) phần nghìn (‰)

 Đơn vị kép: người/km2, sản phẩm/người...
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Các loại số tương đối

• Số tương đối động thái (tốc độ phát triển)

)100(
0y

yK KH
n 

)100(1

KH
T y

yK 

KH

1

0

KH

y

y
 x 

y

y
  

0

1

y
y

Tn KKt  hay

• Số tương đối kế hoạch (lập và kiểm tra kế hoạch)

– Số tương đối nhiệm vụ kế hoạch 

• Mối quan hệ:

– Số tương thực hiện kế hoạch 

)100(
0

1

y
yt 

Các loại số tương đối

• Số tương đối kết cấu: Phản ánh tỷ trọng của từng bộ 
phận cấu thành trong một tổng thể. 

(100)   i
i

i

y
yd
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Các loại số tương đối

• Số tương đối không gian: so sánh giữa hai hiện tượng 
cùng loại nhưng khác nhau về không gian hoặc là quan 
hệ so sánh mức độ giữa hai bộ phận trong một tổng thể

Các loại số tương đối

Số tương đối cường độ: so sánh chỉ tiêu của hai hiện
tượng khác nhau nhưng có quan hệ với nhau. 
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3. Vận dụng chung số tương đối và
tuyệt đối trong thống kê

• Phân tích lý luận KTXH, đặc điểm của hiện tượng 
nghiên cứu để rút ra kết luận

• Vận dụng kết hợp số tương đối với số tuyệt đối

II. Các mức độ trung tâm

Số bình quân (trung bình)1

Mốt (Mo)2

Trung vị (Me)3
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1. Số bình quân (trung bình) 

Khái niệm chung 

Các loại số bình quân

Hạn chế của số bình quân

Đặc điểm của số bình quân

Điều kiện vận dụng số bình quân trong thống kê 

Khái niệm

 Số bình quân trong thống kê là mức độ đại biểu 
theo một tiêu thức nào đó của một tổng thể bao 
gồm nhiều đơn vị.
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Tác dụng

• Phản ánh mức độ đại biểu, nêu lên đặc trưng chung nhất
của tổng thể

• So sánh các hiện tượng không có cùng quy mô.

1.2 Các loại số bình quân

Số trung bình = Tổng lượng biến của tiêu thức
Tổng số đơn vị

a. Số bình quân cộng (áp dụng khi các lượng biến có quan hệ tổng)
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a. Số bình quân cộng

Số bình quân cộng giản đơn (khi dữ liệu chưa phân tổ)

n
    

x  ...  x  x
  n21 
 ix

n
x

a. Số bình quân cộng

Số bình quân cộng gia quyền








i

i

n2

n21    
  ...    

  ...    
  

f
fx

fff
fxfxfxx in

1

21

 idxx i   
i

i

f
fd


   i
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a. Số bình quân cộng

iii fxM 

 Số bình quân điều hoà gia quyền









i

i

i

n

n

n

x
M
M   

 
x

M  ... 
x

M  
x

M
 M...  M M  x

2

2

1

1

21

Tổng lượng biến tổ thứ i

a. Số bình quân cộng




ix

n  x 1

 Số bình quân điều hoà giản đơn (áp dụng khi các Mi
bằng nhau)
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b. Số bình quân nhân

 Số bình quân nhân (áp dụng khi các lượng biến có 
quan hệ tích)
– Số bình quân nhân giản đơn 

 x     x...  x x  x n
i

n
n  21

  i ii n f f
i

f f
n

ff x     x...  x x  x 21
21

 Số bình quân nhân gia quyền

Đặc điểm của số bình quân 

•Mang tính tổng hợp, khái quát cao.

•San bằng các chênh lệch giữa các đơn vị về trị số của tiêu

thức nghiên cứu.

•Chịu ảnh hưởng của các lượng biến đột xuất.
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1.3 Điều kiện vận dụng số bình quân

• Số bình quân chỉ nên tính ra từ tổng thể đồng
chất.

• Số bình quân chung cần được vận dụng kết hợp
với các số bình quân tổ hoặc dãy số phân phối.

2. Mốt (Mode) 

Khái niệm

Cách xác định

Tác dụng
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Khái niệm  

Mốt là biểu hiện của tiêu thức phổ biến nhất (gặp

nhiều nhất) trong một tổng thể hay trong một dãy

số phân phối

Cách xác định  

 Đối với trường hợp phân tổ không có khoảng cách tổ, 
mốt là lượng biến có tần số lớn nhất.

max) i(f x  ioM
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Cách xác định  

 Đối với trường hợp phân tổ có khoảng cách tổ

Bước1: Xác định tổ có mốt, là tổ có tần số lớn nhất (khi k/c tổ 
bằng nhau, hoặc là tổ có mật độ phân phối lớn nhất khi k/c 
tổ không bằng nhau)

Cách xác định  

Bước 2: Xác định trị số gần đúng của mốt:

21

1
MM   

 
h  x  

oo 



 (min)oM

1

1








MoMo

MoMo

ff
ff

2

1




1

1








MoMo

MoMo

mm
mm

2

1




Khoảng cách bằng nhau

Khoảng cách không bằng nhau
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Tác dụng

• Là mức độ đại biểu nên có thể thay thế hoặc bổ sung cho 
trung bình cộng trong trường hợp tính trung bình gặp khó
khăn

• Có ý nghĩa hơn số bình quân cộng trong trường hợp dãy số có
lượng biến đột xuất

• Là một trong những tham số nêu lên đặc trưng phân phối của
dãy số

• Có tác dụng trong phục vụ nhu cầu hợp lý

Hạn chế của mốt

• Không xác định được mốt trong trường hợp dãy số phân phối
không bình thường.
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3. Trung vị (Median) 

Khái niệm

Cách xác định

Tác dụng

Khái niệm  

Trung vị là lượng biến của đơn vị đứng ở vị trí

giữa trong một dãy số, chia dãy số thành hai phần

bằng nhau
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Cách xác định   

+ Nếu số đơn vị tổng thể lẻ (fi = 2m + 1): 1mx Me

2
1mx  

 mxMe+ Nếu số đơn vị tổng thể chẵn (fi = 2m): 

 Trường hợp phân tổ không có khoảng cách tổ 

Cách xác định   

Trường hợp phân tổ có khoảng cách tổ:
- Bước 1: Xác định tổ chứa Me (tổ chứa đơn vị ở vị trí giữa 

trong dãy số)
- Bước 2: Xác định trị số gần đúng

Me

i

f

f

Me
-1)(Me

MeMe

 S- 
h  x  2

(min)






18/01/2018

57

Tác dụng  

min ii fMex

• Là mức độ đại biểu nên có thể thay thế hoặc bổ sung 
cho trung bình cộng trong trường hợp tính trung bình 
gặp khó khăn

• Có ý nghĩa hơn số bình quân cộng trong trường hợp 
dãy số có lượng biến đột xuất

• Là một trong những tham số nêu lên đặc trưng phân 
phối của dãy số

• Có tác dụng trong phục vụ công cộng

* Đặc trưng phân phối của dãy số

X Me Mo

Lệch trái

Mo Me X 

Lệch phải

X = Me = Mo

Đối xứng
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III. Các tham số đo độ phân tán (biến
thiên)

Khoảng biến thiên1

Độ lệch tuyệt đối bình quân2

Phương sai3

Độ lệch tiêu chuẩn4

Hệ số biến thiên5

1. Khoảng biến thiên

• Là chênh lệch giữa lượng biến lớn nhất và
lượng biến nhỏ nhất của tiêu thức nghiên cứu

R = Xmax - Xmin
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2. Độ lệch tuyệt đối bình quân

• Là số bình quân cộng của các độ lệch tuyệt đối 
giữa các lượng biến với số bình quân cộng của 
các lượng biến đó

n

x - x
  d i




i

ii

f

f x - x
  d

(cã 
quyÒn 

sè)

3. Phương sai

Là số bình quân cộng của bình phương các độ
lệch giữa các lượng biến với số bình quân cộng
của các lượng biến đó

1
2


 

n
S

2
i )x - (x

  





1
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2
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  ifS
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4. Độ lệch tiêu chuẩn

• Là căn bậc hai của phương sai

2SS   

5. Hệ số biến thiên

• Là số tương đối (%) tính bằng cách so sánh
giữa độ lệch tiêu chuẩn với số bình quân cộng

100  
x

  
SV

Là thước đo độ biến thiên tương đối, có thể dùng để 
so sánh giữa các hiện tượng khác loại hoặc cùng loại 
và có số bình quân khác nhau
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Ứng dụng SPSS trong tính toán thống kê mô tả

121

Chọn Analyze > Descriptive Statistics > Frequencies…

Đưa các biến cần tính toán các
tham số sang Variable(s)
Nhấn Statistic…

Ứng dụng SPSS trong tính toán thống kê mô tả

122

Chọn Analyze > Descriptive Statistics > Frequencies…

Chọn các thống kê cần tính toán
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I

NHỮNG VẤN ĐỀ 
CHUNG VỀ ĐIỀU 
TRA CHỌN MẪU

II

ĐIỀU TRA CHỌN 
MẪU NGẪU NHIÊN

CHƯƠNG VI: ĐIỀU TRA CHỌN MẪU

III

KIỂM ĐỊNH GIẢ 
THUYẾT THỐNG KÊ

I. Những vấn đề chung

Khái niệm1

Ưu điểm2

Trường hợp vận dụng4

Hạn chế3
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Khái niệm

ĐTCM là một loại điều tra không toàn bộ trong
đó người ta chỉ chọn ra một số đơn vị đủ lớn
thuộc đối tượng nghiên cứu để tiến hành điều
tra thực tế. Các đơn vị này được chọn theo
những quy tắc nhất định để đảm bảo tính đại
biểu và kết quả của ĐTCM được dùng để suy
rộng cho tổng thể chung

Ưu điểm
+ Tiết kiệm (chi phí, nhân lực)

+ Mở rộng nội dung điều tra 

+ Tài liệu thu được trên mẫu có độ chính xác cao

+ Nhanh gọn, đảm bảo tính kịp thời
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Hạn chế
+ Không cho biết thông tin đầy đủ về tổng thể

+ Sai số khi suy rộng

+ Kết quả điều tra không thể tiến hành phân tổ theo 

mọi phạm vi nghiên cứu

Trường hợp vận dụng

• Thay thế cho điều tra toàn bộ

• Kết hợp với điều tra toàn bộ

• Kiểm định giả thuyết thống kê
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II. Ước lượng kết quả điều tra chọn mẫu

Tổng thể chung và tổng thể mẫu1

Cách chọn2

Ước lượng (suy rộng) kết quả điều tra 3

Xác định kích thước (quy mô) mẫu4

1. Tổng thể chung và tổng thể mẫu

Chỉ tiêu Tổng thể chung Tổng thể mẫu

Quy mô

Số bình quân
Tỷ lệ theo một 
tiêu thức

Phương sai

 x

2

)1( ff 

2S

)1( pp 

p f

N n
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2. Cách chọn

 Chọn hoàn lại (chọn lặp, chọn nhiều lần): Quy
mô tổng thể không đổi

số mẫu có thể có:

)!(!
!

nNn
Nk




nNk 

• Chọn không hoàn lại (chọn không lặp, chọn một
lần): Quy mô tổng thể giảm

số mẫu có thể có: 

3. Ước lượng kết quả điều tra
• Với mức ý nghĩa α
• Ước lượng trung bình

xx zxzx   .. 2/2/ 

Khi biết phương sai tổng thể chung (hoặc chưa biết phương 
sai tổng thể chung & mẫu lớn)

Khi chưa biết phương sai tổng thể chung

  xzx .
xzx   .

x
n

x
n txtx   .. 11

2/2/
 

   x
ntx .1

x
ntx   .1

Hai phía
Vế trái
Vế phải

Hai phía
Vế trái
Vế phải
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2. Ước lượng kết quả điều tra

• Với mức ý nghĩa α

• Ước lượng tỷ lệ

ff zfpzf   .. 2/2/ 
 pzf f .

fzxp  .

Hai phía
Vế trái
Vế phải

2. Ước lượng kết quả điều tra

 Trong đó được gọi là hệ số tin cậy (giá trị tới hạn mức α

của phân phối chuẩn hoá và phân phối Student)
 tz ,

• α – mức ý nghĩa

• (1-α) là xác suất hay trình độ tin cậy
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Sai số bình quân chọn mẫu
Cách chọn

Suy rộng
Hoàn lại

(chọn nhiều lần)
Không hoàn lại
(chọn một lần)

Số bình quân

Tỷ lệ

nx

2 

n
S

x

2



)1(
2

N
n

nx 


)1(
2

N
n

n
S

x 

n
ff

f
)1( 

 )1()1(
N
n

n
ff

f 




Các nguyên nhân sai số trong ĐTCM

- Vi phạm nguyên tắc chọn mẫu ngẫu nhiên
- Số lượng đơn vị mẫu không đủ lớn
- Kết cấu tổng thể mẫu khác với kết cấu tổng thể

chung
- Sai số do đăng ký, ghi chép
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4. Xác định số đơn vị mẫu điều tra

• Yêu cầu:

+ Sai số nhỏ nhất

+ Chi phí thấp nhất

Cách xác định

Cách chọn
Suy rộng

Chọn hoàn lại
(chọn nhiều lần)

Chọn không hoàn lại
(chọn một lần)

Bình quân

Tỷ lệ

2

22

x

zn



 222

22

..
..



zN

zNn
x 



2

2 )1(.

f

ppzn




)1(..

)1(..
22
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ppzNn
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+ Hệ số tin cậy (z)/Trình độ tin cậy

+ Phương sai (độ đồng đều) của tổng thể chung (2)

+ Phạm vi sai số chọn mẫu ()

+ Phương pháp tổ chức chọn mẫu

Các nhân tố ảnh hưởng tới kích thước
mẫu điều tra

Ứng dụng SPSS trong ước lượng kết quả điều tra 

140

Chọn Analyze > Descriptive Statistics > Explore …

Đưa các biến cần tính toán các
tham số sang Dependent List
Muốn phân tích theo biến nào
đó thì đưa sang biến sang
Factor List
Trong mục Display chọn
Statistics hoặc Both
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III. Kiểm định giả thuyết thống kê 

Những vấn đề chung về kiểm định giả thuyết thống kê 1

Kiểm định giá trị trung bình 1 tổng thể2

Giả thuyết thống kê
Là giả thuyết về một vấn đề nào đó của tổng thể
chung (về các tham số như trung bình, tỷ lệ, 
phương sai, dạng phân phối,…) 
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Giả thuyết thống kê
Giả thuyết mà ta muốn kiểm định (H0)

Giả thuyết đối lập (Ha, H1, H)

Giả thuyết thống kê
Kiểm định 2 phía

Ví dụ:

H0:  = 0

H1:   0

0

Bác bỏ H0 Bác bỏ H0
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Giả thuyết thống kê
Kiểm định phía trái

Ví dụ:

H0:  = 0

H1:  < 0

0

Bác bỏ H0

Giả thuyết thống kê
Kiểm định phía phải

Ví dụ

H0:  = 0

H1:  > 0

0

Bác bỏ H0
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Sai lầm và mức ý nghĩa trong kiểm định

- Sai lầm loại I là bác bỏ H0 khi H0 đúng

- Sai lầm loại II là chấp nhận H0 khi H0 sai

Sai lầm và mức ý nghĩa trong kiểm định

Kết luận
Thực tế Chấp nhận H0 Bác bỏ H0

H0 đúng Kết luận đúng Sai lầm loại I

H0 sai Sai lầm loại II Kết luận đúng
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Sai lầm và mức ý nghĩa trong kiểm định

Mức ý nghĩa của kiểm định () là xác suất mắc sai

lầm loại I

 = P(Bác bỏ H0/H0 đúng)

Tiêu chuẩn kiểm định
Tiêu chuẩn kiểm định là quy luật phân phối 
xác suất nào đó dùng để kiểm định.

Trong tập hợp các kiểm định thống kê có cùng 
mức ý nghĩa , kiểm định nào có xác suất mắc 
sai lầm loại 2 nhỏ nhất được xem là “tốt nhất”.
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Các bước tiến hành kiểm định

- Xây dựng giả thuyết H0 và giả thuyết đối H1

- Xác định mức ý nghĩa 

- Chọn tiêu chuẩn kiểm định

- Tính giá trị của tiêu chuẩn kiểm định từ mẫu 
quan sát

- Kết luận

Kết luận
Quy tắc kiểm định giả thuyết thống kê

- Nếu giá trị tiêu chuẩn kiểm định thuộc miền bác
bỏ (W), kết luận H0 sai, có cơ sở để bác bỏ H0

- Nếu giá trị của tiêu chuẩn kiểm định không
thuộc miền bác bỏ, chưa khẳng định H0 đúng mà
kết luận chưa đủ cơ sở để bác bỏ H0
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Phương pháp tiếp cận P-value trong kiểm
định giả thuyết

• Rất nhiều phần mềm thống kê tính P-value (sig) khi thực hiện
kiểm định giả thuyết.

• P-value là xác suất lớn nhất để có thể bác bỏ giả thuyết
H0. P-value thường được xem như là mức ý nghĩa quan
sát.

• Các nguyên tắc ra quyết định để bác bỏ giả thuyết H0 với P-
value là:

• Nếu p-value lớn hơn hoặc bằng α, chưa đủ cơ sở để bác bỏ
giả thuyết H0.

• Nếu p-value nhỏ hơn α, bác bỏ giả thuyết H0.

Kiểm định giả thuyết về giá trị trung bình 
của một tổng thể chung

- Giả sử nghiên cứu X  N(, 2)

- Chưa biết  song có cơ sở để giả định nó bằng
0 (H0:  = 0)

- Để kiểm định giả thuyết trên, lấy ngẫu nhiên n 
đơn vị từ đó tính các tham số của mẫu.

- Tiêu chuẩn kiểm định
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Kiểm định giả thuyết về giá trị trung bình 
của một tổng thể chung

Tiêu chuẩn kiểm định

Trong đó

)1(
0 ~

/
)(




 nt

nS
xT 

 22
2

2 )(
11

)( xx
f

f
f

fxxS
i

i

i

ii 










Miền bác bỏ W

- Hai phía: Tqs > t/2(n-1)

- Vế phải: Tqs > t(n-1)

- Vế trái: Tqs < -t(n-1)

Kiểm định giả thuyết về giá trị trung 
bình của một tổng thể chung
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Ứng dụng SPSS trong kiểm định giả thuyết 
thống kê 

157

Analyze > Compare Means > One-Sample T Test…

Đưa các biến cần kiểm định giá trị trung 
bình vào Test Variable(s)

Nhập giá trị cần kiểm định trung bình 
vào Test Value

Nhấn Options...

Ứng dụng SPSS trong kiểm định giả thuyết thống kê 

158

Analyze > Compare Means > One-Sample T Test…

Nhập độ tin cậy của kiểm định vào 
Confidence Interval

Chỉ kiểm định đối với các quan sát có ý 
nghĩa của biến chọn Exclude cases 
analysis by analysis

Chỉ kiểm định đối với các quan sát có 
đầy đủ trong các biến chọn Exclude 
cases listwise (n như nhau)
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I

NHIỆM VỤ CỦA 
PHÂN TÍCH
HỒI QUY VÀ 

TƯƠNG QUAN

II

PHÂN TÍCH HỒI 
QUY TUYẾN TÍNH 

ĐƠN

III

PHÂN TÍCH HỒI 
QUY TUYẾN TÍNH 

BỘI

CHƯƠNG V: PHÂN TÍCH HỒI QUY VÀ 
TƯƠNG QUAN

I. Nhiệm vụ của phân tích hồi quy và
tương quan

Mối liên hệ của các hiện tượng kinh tế xã hội1

Nhiệm vụ của phân tích hồi quy và tương quan2
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1. Mối liên hệ của các hiện tượng kinh tế xã hội

Liên hệ hàm số

Liên hệ tương quan

Liên hệ hàm số

• Khái niệm: liên hệ hàm số là mối liên hệ hoàn 
toàn chặt chẽ

• Đặc điểm: Liên hệ được biểu hiện trên từng 
đơn vị cá biệt
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Liên hệ tương quan

• Khái niệm: liên hệ tương quan là mối liên hệ
không hoàn toàn chặt chẽ.

• Đặc điểm: Liên hệ không được biểu hiện trên
từng đơn vị cá biệt mà phải quan sát số lớn

2. Nhiệm vụ của phân tích hồi quy và
tương quan

 Xây dựng phương trình hồi quy.

 Đánh giá trình độ chặt chẽ của mối liên hệ
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II. Hồi quy – tương quan đơn

Xây dựng phương trình hồi quy1

Đánh giá phương trình hồi quy2

1. Phương trình hồi quy

 Đường hồi quy lý thuyết: là đường điều chỉnh bù trừ các chênh
lệch ngẫu nhiên nêu ra mối liên hệ cơ bản của hiện tượng.

Đường hồi quy lý thuyết



x

y

0




 






 Phương trình hồi quy: là phương trình xác định vị trí của đường
hồi quy lý thuyết
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Phương trình hồi quy tổng thể

iii xY   10

Tham số tự do (hệ số chặn)

Biến độc lập
Biến giải thích
Công cụ dự báo
Ngoại sinh
Tác nhân kích thích
Nguyên nhân

Hệ số hồi quy (hệ số góc)

Biến phụ thuộc
Biến được giải thích
Dự báo
Nội sinh
Câu trả lời
Kết quả

Ý nghĩa các tham số

• β0: phản ánh ảnh hưởng của các nguyên nhân khác
(ngoài nguyên nhân x) tới kết quả y

• β1: phản ánh ảnh hưởng trực tiếp của nguyên nhân
x tới kết quả y. Cụ thể, khi x tăng thêm 1 đơn vị thì
y thay đổi bình quân là β1 đơn vị

β1 > 0: x và y có mối liên hệ thuận (cùng chiều)

β1 < 0: x và y có mối liên hệ nghịch (ngược chiều)
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Phương trình hồi quy mẫu

Ước lượng của tham số β0 Ước lượng của tham số β1

Với một mẫu ngẫu nhiên kích thước n, chúng ta có phương 
trình hồi quy mẫu như sau: 

ii xbby 10ˆ 

Giả thiết OLS

+ Giả thiết 1: Mô hình được ước lượng trên cơ sở mẫu ngẫu nhiên
+ Giả thiết 2: Kỳ vọng toán của sai số bằng không
+ Giả thiết 3: Sai số tuân theo quy luật phân bố chuẩn
+ Giả thiết 4: Phương sai của sai số bằng nhau (không đổi)
+ Giả thiết 5: Biến độc lập và sai số không có tương quan với nhau
(không có tự tương quan)
+ Giả thiết 6: Giữa các biến độc lập không có tương quan tuyến tính
hoàn hảo (đa cộng tuyến) - Đối với hồi quy bội.
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Phương pháp bình phương nhỏ nhất 
(OLS)

Tìm các tham số sao cho tổng bình phương các
chênh lệch giữa giá trị thực tế và giá trị lý thuyết
của tiêu thức kết quả là nhỏ nhất.
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Kiểm định hệ số hồi quy

• Giả thuyết: 
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• Tiêu chuẩn kiểm định:

• Nếu H0 đúng thống kê T sẽ tuân theo quy luật phân phối
student với (n-2) bậc tự do. 

Kiểm định hệ số hồi quy

Miền bác bỏ giả thuyết H0 (W)

- Hai phía: Tqs > t/2 ,(n-2)

- Vế phải: Tqs > t (n-2)

- Vế trái: Tqs < -t(n-2)
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Ước lượng hệ số hồi quy

• Hai phía:

• Phái phải:

    )()( 2
2

2
2 j

n
jjj

n
j bsetbbsetb    

  )(2
j

n
jj bsetb  

• Phái trái:    
jj

n
j bsetb  )(2

Hệ số xác định

 



n

i
i yySSR

1

2ˆ

 



n

i
ii yySSE

1

2ˆ

Biến thiên được giải thích bởi hồi quy

Biến thiên do phần dư

Toàn bộ biến thiên của biến phụ thuộc

SST = SSR + SSE

Hệ số xác định
SST
SSE

SST
SSRR  12

Phản ánh phần trăm thay đổi của biến phụ thuộc được giải thích bởi biến độc lập

 



n
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i yySST

1
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Kiểm định ý nghĩa mô hình

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê F sẽ tuân theo quy luật phân phối Fisher với bậc tự do (1, n-2)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi, F > fα(1.n-2)

Cặp giả thuyết




nghia ý cóhình  Mô:
nghia ý có khônghình  Mô:

1H
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Hệ số tương quan tuyến tính

Tác dụng

- Xác định chiều hướng của mối liên hệ

- Đánh giá mức độ chặt chẽ của liên hệ tương quan

tuyến tính

Tính chất của hệ số tương quan

-1 0 +1 

Liên hệ hàm sốKhông có mối liên hệ

Mối liên hệ thuận càng chặt chẽ

Liên hệ hàm số

Mối liên hệ nghịch càng chặt chẽ
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R2 = 1,Y
Yi = b0 + b1Xi

X

^
r = -1

R2 < 1,Y

Yi = b0 + b1Xi

X
^

r <1

R2 = 1,Y

Yi = b0 + b1Xi
X

^

r = +1

R2 = 0,Y

Yi = b0 + b1Xi

X
^

r = 0

TÝnh chÊt cña hÖ sè tư¬ng quan tuyÕn tÝnh

Kiểm định hệ số tương quan

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê T sẽ tuân theo quy luật phân phối student với bậc tự
do (n-2)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi

Cặp giả thuyết
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III. Hồi quy – tương quan bội

Xây dựng phương trình hồi quy1

Đánh giá phương trình2

Phương trình hồi quy tổng thể

ikikiii xxxY   ....22110

β0 - Tham số tự do (hệ số chặn)

βj (j=1-k) Hệ số hồi quy riêng
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Ý nghĩa hệ số hồi quy

• βj: phản ánh ảnh hưởng thuần của nguyên nhân xj

tới kết quả y (khi các yếu tố khác không đổi). Cụ
thể, khi xj tăng thêm 1 đơn vị thì y thay đổi trung
bình là βj đơn vị

Phương trình hồi quy mẫu

iii xbxbby 22110ˆ 

b0: Ước lượng của tham số β1

b1, b2: Ước lượng của tham số β1, β2

Với một mẫu ngẫu nhiên kích thước n, chúng ta có phương
trình hồi quy mẫu (trường hợp 2 biến) như sau: 
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Phương pháp bình phương nhỏ nhất 
(OLS)














2
22211202

212
2
11101

22110

...
...

...

iiiiii

iiiiii

iii

xbxxbxbyx
xxbxbxbyx

xbxbbny

b0, b1, b2 là nghiệm của hệ phương trình sau:

Kiểm định hệ số hồi quy

• Giả thuyết: 

)(

*

j

jj

bse
b

T




*
0 : jjH  

• Tiêu chuẩn kiểm định:

• Nếu H0 đúng thống kê T sẽ tuân theo quy luật phân phối
student với (n-k-1) bậc tự do. 
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Kiểm định hệ số hồi quy

• Trong đó:  

        



  
















n

i

n

i

n

i
iiii

n

i
i

xxxxxxxx

xx
bse

1 1

2

1
2211

2
22

2
11

1

2
22

2

1
2 )(



 
 

        



  
















n

i

n

i

n

i
iiii

n

i
i

xxxxxxxx

xx
bse

1 1

2

1
2211

2
22

2
11

1

2
11

2

2
2



1
2




kn
SSE

Kiểm định hệ số hồi quy

Miền bác bỏ giả thuyết H0 (W)

- Hai phía: Tqs > t/2 ,(n-k-1)

- Vế phải: Tqs > t (n-k-1)

- Vế trái: Tqs < -t(n-k-1)
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Ước lượng hệ số hồi quy

• Hai phía:

• Phái phải:

    )()( 1
2

1
2 j

kn
jjj

kn
j bsetbbsetb    

  )(1
j

kn
jj bsetb  

• Phái trái:
   

jj
kn

j bsetb  )(1

Hệ số hồi quy chuẩn hoá

• Công thức: 

y

xj
jj bBêta





• Biểu hiện vai trò của từng biến độc lập tới biến thuộc
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Hệ số xác định

 



n

i
i yySSR

1

2ˆ

 



n

i
ii yySSE

1

2ˆ

SST = SSR + SSE

Hệ số xác định
SST
SSE

SST
SSRR  12

Phản ánh phần trăm thay đổi của biến phụ thuộc được giải thích bởi các biến độc lập

 



n

i
i yySST

1

2

Biến thiên được giải thích bởi hồi quy

Biến thiên do phần dư

Toàn bộ biến thiên của biến phụ thuộc

Hệ số xác định điều chỉnh

Hệ số xác định điều chỉnh
1

)1)(1(1

1

11
2

2









kn

nR

n
SST

kn
SSE

Radj

Khi k >1 thì R2
adj ≤ R2≤1

K càng lớn R2
adj càng nhỏ so với R2

R2
adj có thể âm, sẽ quy ước R2

adj = 0

Dùng để so sánh, đánh giá độ phù hợp của mô hình khi số lượng biến trong
mô hình hồi quy khác nhau
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Kiểm định ý nghĩa mô hình

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê F sẽ tuân theo quy luật phân phối Fisher với bậc tự do
(k, n-k-1)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi, F > fα(k, n-k-1)

Cặp giả thuyết








0...:

0...:
22

2
2

11

21

k

ko

H

H





 
 2

2

1
1

1
Rk
knR

kn
SSE

k
SSR

F









Hệ số tương quan chung

Công thức 21 R
SST
SSR

SST
SSER 
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Ứng dụng SPSS trong phân tích HQ

197

Analyze > Regression > Linear…

Đưa biến phụ thuộc sang 
Dependent

Đưa các biến độc lập sang 
Independent(s) 

I

KHÁI NIỆM CHUNG 
VỀ DÃY SỐ THỜI 

GIAN

II

PHÂN TÍCH ĐẶC 
ĐIỂM BIẾN ĐỘNG 
CỦA HIỆN TƯỢNG 
QUA THỜI GIAN

III

BIỂU DIỄN XU 
HƯỚNG BIẾN 

ĐỘNG CỦA HIỆN 
TƯỢNG

IV

DỰ ĐOÁN THỐNG 
KÊ NGẮN HẠN

CHƯƠNG V: PHÂN TÍCH DÃY SỐ THỜI GIAN
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Khái niệm1

Tác dụng3

Các thành phần của dãy số thời gian5

Yêu cầu4

Phân loại2

I. Khái niệm chung về dãy số thời gian

1. Khái niệm

Dãy số thời gian là một dãy trị số của chỉ tiêu thống
kê được sắp xếp theo thứ tự thời gian
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1. Khái niệm

Thời gian: ngày, tháng, quý, năm,… Độ dài

giữa hai thời gian là khoảng cách thời gian

Chỉ tiêu về hiện tượng nghiên cứu: tên chỉ

tiêu, đơn vị tính và trị số chỉ tiêu yi (i=1,n) là

mức độ của dãy số thời gian

2. Phân loại

Dãy số tuyệt đối

 Dãy số tương đối

 Dãy số bình quân

Thời điểm

 Thời kỳ
DS-TG
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3. Tác dụng

 Cho phép thống kê nghiên cứu các đặc điểm về sự
biến động của hiện tượng qua thời gian và xác định xu
hướng và tính quy luật của sự phát triển.

 Là cơ sở dự đoán thống kê

4. Yêu cầu chung khi xây dựng DSTG

Đảm bảo tính chất có thể so sánh được giữa các 
mức độ của dãy số thời gian
 Các mức độ phải thống nhất về nội dung và 
phương pháp tính chỉ tiêu qua thời gian.
 Các mức độ phải thống nhất về phạm vi tổng thể 
nghiên cứu.
 Các khoảng cách thời gian trong dãy số thời kỳ 
phải bằng nhau.
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Dãy số thời gian

Chu kỳ 
(Cyclical 

Componen)

Ngẫu nhiên 
(Irregular 

Componen)

Xu thế 
(Trend 

Componen)

Thời vụ
(Seasonality 
Componen)

5. Các thành phần của DSTG

5. Các thành phần của dãy số thời gian

Giả sử dãy số không có thành phần chu kỳ. Khi đó một dãy
số thời gian chỉ bao gồm ba thành phần cơ bản là xu thế, biến
động thời vụ và biến động ngẫu nhiên.
Các thành phần này có thể kết hợp theo nhiều dạng khác nhau
trong, đó có hai dạng phổ biến là:
- Mô hình kết hợp theo dạng cộng: Y = T + S + I
- Mô hình kết hợp theo dạng nhân: Y = T x S x I
trong đó: Y là mức độ của dãy số.
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II. Phân tích đặc điểm biến động của hiện
tượng qua thời gian

Mức độ bình quân qua thời gian1

Tốc độ phát triển 3

Giá trị tuyệt đối của 1% của tốc độ tăng (giảm)5

Tốc độ tăng (giảm)4

Lượng tăng (giảm) tuyệt đối 2

1. Mức độ bình quân qua thời gian

 Ý nghĩa: Mức độ bình quân theo thời gian phản ánh mức

độ đại biểu của tất cả các mức độ của dãy số.

n

y

n
yyyyy

n

i
i

nn

 


 1121 ...

* Cách tính

+ Đối với dãy số thời kỳ:
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1. Mức độ bình quân qua thời gian

+ Đối với dãy số thời điểm:

2
CKDK yyy 

* Dãy số biến động đều:

1. Mức độ bình quân qua thời gian

1
2

...
2 12

1








n

yyyy

y
n

n

+ Đối với dãy số thời điểm:

* Dãy số biến động không đều, có số liệu tại thời điểm có
khoảng cách thời gian bằng nhau:
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1. Mức độ bình quân qua thời gian

i

ii

t
tyy






+ Đối với dãy số thời điểm:
* Dãy số biến động không đều, có số liệu tại thời điểm có
khoảng cách thời gian không bằng nhau:

2. Lượng tăng (giảm) tuyệt đối

Ý nghĩa: Phản ánh sự biến động về trị số tuyệt đối của chỉ tiêu 
qua thời gian
- Liên hoàn

- Định gốc





i

i
ii

2


1 iii yy

1yyii 

- Mối liên hệ

111
12















n

yy

nn
nn

n

i
i


- Bình quân
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3. Tốc độ phát triển

Ý nghĩa: tốc độ và xu hướng biến động của hiện tượng qua 
thời gian
- Liên hoàn

- Định gốc





i

i
ii tT

2

)100(
1


i

i
i y

yt

)100(
1y

yT i
i 

- Mối liên hệ

- Bình quân 1

1

11

2



  n nn

n
n

n

i
i y

yTtt

4. Tốc độ tăng (giảm) 

Ý nghĩa: mức độ của hiện tượng qua thời gian tăng (giảm) đi 
bao nhiêu lần hoặc %
- Liên hoàn

- Định gốc

)100(1(%))100()100(
11

1 






i

i

i

i

ii
i t

yy
yya 

)100(1(%) ta

)100(1(%))100()100(
11

1 





 i
ii

i T
yy

yyA

- Mối liên hệ:   Không có mối liên hệ

- Bình quân
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5. Giá trị tuyệt đối của 1% của tốc độ tăng (giảm) 

Ý nghĩa: 1% tăng/giảm của tốc độ tăng/giảm thì tương ứng
với một trị số tuyệt đối là bao nhiêu
- Liên hoàn

- Định gốc

100100(%)
1

1





 i

i

i

i

i

i
i

y

y
a

g 


consty

y
A

G
i

i

i

i
i 








100100(%)

1

1

- Mối liên hệ:   Không có mối liên hệ

- Bình quân: không tính

--> Không tính

II. Một số phương pháp biểu diễn xu hướng
phát triển cơ bản của hiện tượng

Hàm xu thế 2

Số bình quân trượt 1
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Dãy số được hình thành bởi
các số bình quân trượt

số bình quân cộng của một
nhóm nhất định các mức độ
được tính bằng cách lần lượt
loại trừ dần mức độ đầu đồng
thời thêm vào các mức độ
tiếp theo sao cho số lượng các
mức độ tham gia tính số bình
quân là không đổi

Số bình quân 
trượt

Dãy số bình quân 
trượt

1. Phương pháp bình quân trượt

Yi Bình quân
trượt

Y1 -
Y2 Ỹ2

Y3 Ỹ3

Y4 :
Y5 :

:
Yn-1 Ỹn-1

yn -

3
321

2
yyy

y




3
12

1
nnn

n
yyy

y


 


2. Phương pháp bình quân trượt
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Hàm số biểu hiện các 
mức độ của hiện 

tượng qua thời gian

Khái niệm Một số dạng 
hàm xu thế

2. Xây dựng hàm xu thế

ii tbby 10ˆ 
2

210ˆ iii tbtbby 

i
i t

bby 1
0ˆ 

it
i bby 10ˆ 

IV. Một số phương pháp dự đoán
thống kê ngắn hạn

Dự đoán dựa vào lượng tăng (giảm) tuyệt đối bình quân1

Dự đoán dựa vào hàm xu thế 3

Dự đoán dựa vào tốc độ phát triển bình quân 2
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Khái niệm chung

• Dự đoán thống kê là xác định mức độ của hiện tượng
trong tương lai bằng cách sử dụng tài liệu thống kê và áp
dụng các phương pháp phù hợp

• Tài liệu thống kê thường được sử dụng trong dự đoán
thống kê là dãy số thời gian

1. Dự đoán dựa vào lượng tăng (giảm) 
tuyệt đối bình quân 

111
12















n

yy

nn
nn

n

i
i



• Mô hình dự đoán: hyy nhn .ˆ 
Trong đó:
yn: Mức độ cuối cùng trong dãy số
h: tầm xa dự đoán

Lượng tăng (giảm) tuyệt đối                                                                                                  
bình quân

Điều kiện áp dụng: Dãy số có các lượng tăng (giảm) tuyệt 
đối liên hoàn xấp xỉ nhau
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2. Dự đoán dựa vào tốc độ phát triển 
bình quân 

1

1

11

2





  n nn
nn

n

i
i y

yTtt

• Mô hình dự đoán:
h

nhn tyy )(ˆ 

Trong đó:
yn: Mức độ cuối cùng trong dãy số
h: tầm xa dự đoán

Tốc độ phát triển bình quân

Điều kiện áp dụng: Dãy số có các tốc độ phát triển liên 
hoàn xấp xỉ nhau

3. Dự đoán dựa vào hàm xu thế

)(ˆ ii tfy • Mô hình dự đoán:
Trong đó:
t: thứ tự thời gian
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Tiêu chuẩn lựa chọn mô hình dự đoán

min)ˆ( 2  ii yySSE

Mô hình tốt nhất là mô hình có:

Ứng dụng SPSS trong dự đoán dựa 
vào hàm xu thế

226

Data>Define Dates..

Dữ liệu thời gian (dữ liệu chuỗi) là dữ liệu mà mỗi dòng (quan sát) là
số liệu ở một thời gian nhất định (tháng, quý, năm,...)
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Ứng dụng SPSS trong dự đoán dựa 
vào hàm xu thế

227

Analyze>Regression > Curve Estimation…

Ứng dụng SPSS trong dự đoán dựa 
vào hàm xu thế

228

Analyze>Regression > Curve Estimation…
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I

NHỮNG VẤN ĐỀ 
CHUNG VỀ 

PHƯƠNG PHÁP CHỈ 
SỐ

II

PHƯƠNG PHÁP 
TÍNH CHỈ SỐ

III

HỆ THỐNG
CHỈ SỐ

CHƯƠNG VI: PHƯƠNG PHÁP CHỈ SỐ

I Những vấn đề chung về phương pháp chỉ
số

Khái niệm1

Các loại chỉ số2

Tác dụng của chỉ số3

Đặc điểm4
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1 Khái niệm 

Chỉ số là số tương đối (tính bằng lần hoặc %) biểu hiện
quan hệ so sánh giữa hai mức độ của cùng một hiện tượng
nghiên cứu

2 Phân loại

CHỈ SỐ

Theo đặc điểm 
quan hệ thiết lập

Theo phạm vi Theo nội dung chỉ 
tiêu

Chỉ số 
phát 
triển

Chỉ số
không
gian

Chỉ số
kế

hoạch

Chỉ số 
đơn (cá 

thể)

Chỉ số 
tổng 
hợp 

(chung)

Chỉ số chỉ 
tiêu chất 

lượng

Chỉ số chỉ 
tiêu số 
lượng
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3. Tác dụng 

- Nghiên cứu sự biến động của hiện tượng qua thời gian: chỉ

số phát triển hay tốc độ phát triển

- Nghiên cứu sự biến động của hiện tượng qua không gian:

chỉ số không gian

- Nêu lên nhiệm vụ kế hoạch hoặc tình hình thực hiện kế

hoạch: chỉ số kế hoạch bao gồm chỉ số nhiệm vụ kế hoạch và

chỉ số hoàn thành kế hoạch

4. Đặc điểm của phương pháp chỉ số

- Khi phản ánh sự biến động của nhiều đơn vị hoặc phần tử
có đặc điểm, tính chất khác nhau, phải chuyển chúng về
dạng giống nhau để có thể trực tiếp cộng được với nhau
dựa vào mối quan hệ giữa nhân tố nghiên cứu với các nhân
tố khác

- Khi có nhiều nhân tố tham gia vào tính toán thì giả định
chỉ có một nhân tố nghiên cứu thay đổi còn các nhân tố
khác cố định (không thay đổi)
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II Phương pháp tính chỉ số

Chỉ số phát triển 1

Chỉ số không gian2

Chỉ số kế hoạch3

1 Chỉ số phát triển

Chỉ số đơn

Chỉ số tổng hợp
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1.1 Chỉ số đơn

 Chỉ số đơn của chỉ tiêu chất lượng (lấy giá bán làm ví

dụ):

)100(
o

1
p p

p
i 

)100(
o

1
q q

q
i 

 Chỉ số đơn của chỉ tiêu số lượng (lấy lượng hàng tiêu

thụ làm ví dụ):

1.2 Chỉ số tổng hợp

Chỉ số tổng hợp của chỉ tiêu chất lượng (lấy giá làm 
ví dụ):




qp

qp
I

o

1
p




oo

o1L
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– Chỉ số tổng hợp của Laspeyres (quyền số ở kỳ gốc)

 pi
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1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Passche (quyền số ở kỳ nghiên cứu) 
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1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Fisher (khi có sự chênh lệch lớn giữa 
chỉ số của Laspayres và Passche) 
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1.2 Chỉ số tổng hợp

Chỉ số tổng hợp của chỉ tiêu số lượng (lấy lượng làm 
ví dụ):
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- Chỉ số tổng hợp của Laspeyres (quyền số ở kỳ gốc)

 qi

1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Passche (quyền số ở kỳ nghiên cứu) 
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1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Fisher (khi có sự chênh lệch lớn giữa 
chỉ số của Laspayres và Passche) 
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2 Chỉ số không gian

Chỉ số đơn

Chỉ số tổng hợp
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Chỉ số đơn

Chỉ số đơn của chỉ tiêu chất lượng (lấy giá p làm ví dụ)

B

A
(A/B) p p

p
i 

A

B
(B/A) p p

p
i 

B

A
(A/B) q q

q
i 

A

B
(B/A) q q

q
i 

hoÆc

hoÆc

 Chỉ số đơn của chỉ tiêu số lượng (lấy lượng hàng tiêu thụ q 
làm ví dụ)

Ký hiệu:
p - giá bán q - lượng hàng tiêu thụ
A, B – Thị trường A, B

Chỉ số tổng hợp

 Chỉ số tổng hợp của chỉ tiêu chất lượng (lấy giá 
làm ví dụ)
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Chỉ số tổng hợp

Chỉ số tổng hợp của chỉ tiêu khối lượng (lấy lượng 
làm ví dụ)
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- Lấy giá do cố định (pn) do nhà nước quy định)
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- Lấy giá trung bình của hai thị trường

2.3. Chỉ số kế hoạch

• Nếu căn cứ vào sản lượng thực tế của doanh 
nghiệp ở các kỳ, ta có 2 loại chỉ số:

+ Chỉ số kế hoạch giá thành:




0

0

qz

qz
I

o

k
z




1

11

qz

qz
I

k
z

+ Chỉ số thực hiện kế hoạch giá thành:
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2.3 Chỉ số kế hoạch

• Nếu căn cứ vào sản lượng kế hoạch của doanh 
nghiệp:

+ Chỉ số kế hoạch giá thành:
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kk
z qz
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I




kk

k
z qz
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I 1

+ Chỉ số thực hiện kế hoạch giá thành:

III Hệ thống chỉ số

Hệ thống chỉ số 1

Phương pháp xây dựng hệ thống chỉ số 2
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Khái niệm 

• Hệ thống chỉ số là một dãy các chỉ số có liên hệ với nhau, 

hợp thành một phương trình cân bằng 

• Cấu thành của một hệ thống chỉ số thường bao gồm một chỉ 

số toàn bộ và các chỉ số nhân tố 

• Ví dụ:

– CS sản lượng = CS NSLĐ  x   CS qui mô lao động

– CS doanh thu =  CS giá   x   CS lượng hàng tiêu thụ

Tác dụng 

Phân tích vai trò và mức ảnh hưởng của các nhân

tố cấu thành hiện tượng chung được cấu thành

bởi các nhân tố đó

 Để tính ra 1 chỉ số chưa biết khi đã biết các chỉ số

còn lại trong hệ thống
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2 Phương pháp xây dựng

Hệ thống chỉ số tổng hợp

Hệ thống chỉ số của chỉ tiêu bình quân

Hệ thống chỉ số của tổng lượng biến tiêu thức

 Quy tắc xây dựng 

 Khi sử dụng phương pháp chỉ số phân tích sự biến động

của một hiện tượng được cấu thành bởi nhiều nhân tố thì

sắp xếp các nhân tố theo trình tự tính chất lượng giảm dần,

tính số lượng tăng dần

 Khi phân tích sự biến động của nhân tố chất lượng sử

dụng quyền số là nhân tố số lượng ở kỳ nghiên cứu, khi

phân tích sự biến động của nhân tố số lượng, sử dụng

quyền số là nhân tố chất lượng ở kỳ gốc



18/01/2018

128

Hệ thống chỉ số tổng hợp 

Cơ sở hình thành
Xuất phát từ mối liên hệ thực tế giữa các hiện tượng bằng
các công thức hoặc các phương trình kinh tế
Ví dụ: Từ mối liên hệ:
DT = Giá bán x Khối lượng hàng hoá tiêu thụ
Xây dựng được hệ thống chỉ số:
(CS toàn bộ) (Chỉ số nhân tố) (Chỉ số nhân tố)

Ipq = Ip x Iq

 Vận dụng phân tích phương trình 
doanh thu 

        001010110011 qpqpqpqpqpqp

Hệ thống chỉ số:
Biến động tương đối:

Ipq = Ip x Iq
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 Biến động tuyệt đối:
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Hệ thống của chỉ tiêu bình quân 
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ii dx
f
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x

Số bình quân cộng gia quyền:

 Chỉ tiêu bình quân chịu ảnh hưởng của hai nhân tố:
 Bản thân lượng biến của tiêu thức nghiên cứu xi;
 Kết cấu tổng thể di

 Hệ thống chỉ số phân tích 
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 Phân tích bằng số tuyệt đối:

 Hệ thống chỉ số:

fdxx III .

)()()( 00101101 xxxxxx 
dfx

x xx


0

01

01

1

0

1

x
x

x
x

x
x





18/01/2018

130

 Tổng lượng biến tiêu thức:   iii f.xfxT

Hệ thống chỉ số của tổng lượng biến tiêu thức

 Các nhân tố ảnh hưởng:
 Bản thân lượng biến của tiêu thức nghiên cứu xi và tần
số tương ứng fi;
 Chỉ tiêu bình quân chung và tổng số đơn vị tổng thể

 Hệ thống chỉ số phân tích (MH1) 
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 Hệ thống chỉ số:

 Phân tích bằng số tuyệt đối
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 Hệ thống chỉ số phân tích (MH2)
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 Hệ thống chỉ số:

 Phân tích bằng số tuyệt đối
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 Hệ thống chỉ số phân tích (MH3)
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 Hệ thống chỉ số:
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